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ArcPad Overview

TEC7133
Phoenix, AZ

November 18-20, 2003



What is ArcPad?

• Mobile GIS mapping “software”designed for handheld 
and mobile devices

• Developed by Environmental Systems Research Institute 
(ESRI) 

• Part of the “ArcGIS” system 



Why ArcPad?
Easily bring your GIS data into the field



Why ArcPad?
Integrate your existing GPS devices



Why ArcPad?

? Standardize data collection 

? Streamline data collection process

? Simplify importing GPS data to your GIS



ArcPad System Requirements

? Any handheld or mobile device that runs Windows CE 
operating system

• Pocket PC, HP Jornada, Toshiba, Panasonic Toughbook…
• Does not work with Palm Pilot/Handspring (PALM OS)
• Also runs on PCs running Windows 95, 98, NT, 2000, XP

• Tablet PCs (Windows XP) were recently added in version 6.0

? Microsoft ActiveSync 3.7  
• Latest version can be downloaded from web

http://www.microsoft.com/windowsmobile/resources/downloads/pocketpc/activesync37.mspx



Add/Manage GIS Layers



Data Formats Supported

? Shapefiles (vector data)

Raster (DOQQs, DRGs..)
JPEG
MrSID
BMP
CADRG
PNG 



Query & Edit Features 



Obtain Area, Distance & Direction 
Information



Data Collection Options

? Ability to set GPS quality and capture rules



Other ArcPad Features

? Navigation 
? Hyperlink (hot link to photos, docs)
? Track Logs
? Add data from Internet via wireless technology
? Ability to CUSTOMIZE !



ArcPad Customization
? Customization done using separate software called 

“ArcPad Studio”

? Design forms for attributing features 
- Layer definition files (*.apl)
- Basic forms can now be created without ArcPad Studio!

? Modify interface (new toolbars, buttons)
- Configuration file (arcpad.apx)
- Applets (*.apa)

? No programming experience required!



Design Custom Forms



Modify ArcPad Interface

Standard Toolbars Customized Toolbars



• ArcPad - $205

• Application Builder - $614
- ArcPad Studio (customization software)
- One ArcPad  license included
- Any forms/configurations/applets can be 

distributed to multiple users

How much does ArcPad cost?

NOTE:   Prices are based on 50% off GSA price 
discount available through DOI Enterprise agreement



Handheld Devices used in Class

? Compaq iPAQ Pocket PC – Model #3650
• 32 MB of RAM
• 16 MB of ROM
• Windows CE 3.0 Operating System

? TeleType GPS World Navigator
• PCMCIA Card
• 12 channel receiver



Handheld Devices used in Class
? Trimble GeoCE

• 206 MHz StrongARM processor
• 64 MB of RAM
• Windows CE 3.0 Operating System

? GeoXM Model 
• Integrated GPS
• 8 channel receiver
• WAAS 



 
 

Section 2 
 

 
 

Getting Familiar with ArcPad 
 

 
 
 
Section 2 Objectives:   
 

At the end of this section, you will be able to:  
 

o Utilize the basic functionality of ArcPad software on a 
handheld   device 
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Getting Familiar with ArcPad 6 

 
In this exercise you will explore some of the basic functionality of ArcPad 6.    
 
NOTE: This exercise was developed using ArcPad version 6.0.2 
 
 
Adding layers and setting their properties  

 
1. From the Windows desktop, double click on ArcPad to launch the 

program.   
 

2. Click the Add Layer  button.    
 

3. In the Add Layers dialog, click on the Folder  button and navigate 
to the \tec7133\nctc folder.  Click OK. 

 
4. Check all boxes to add the following six layers to ArcPad: 

 

 
 
TIP:  If you put a check in the box next to the folder, all layers in the folder will 
be added to your map. 
 
 
5. Click OK after checking the above layers. 

 
6. Click on the Layers  button.   
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7. In the Layers dialog, click on the Projection Information  button.   

 
What is the map projection being used? 
Projection Type: ________________________ 
 
Which datum is being used? 
Datum Name: ________________________ 
 
Close the Projection Information dialog. 
 
NOTE:    In this example, all of the shapefiles added to the ArcPad 
project have an associated projection file (*.prj).  Therefore, the 
presence of this file automatically defines the map projection for the 
ArcPad map.   If the shapefiles did not have projection files, ArcPad 
automatically assigns decimal degrees based on the WGS84 datum as 
the default projection for the ArcPad map.  Therefore, if your shapefile 
does not have a projection file and it’s native format is not decimal 
degrees, you must use the Choose Map Projection Definition File 

 button and define a map projection for the ArcPad map.  Numerous 
map projection definition files are provided by ArcPad and located in 
the C:\Program Files\ArcPad\Coordinate Systems folder.   
 

 
8. From the Layers dialog, click on the Buildings.shp layer to select it.    

Click on the Layer Properties  icon.  Scroll over and select the 
Symbology tab.  Uncheck the Use Symbology box.  This will allow you 
to assign a single symbol to represent building features. 

 
NOTE:   The symbology for this layer was defined using ArcPad Tools.    
ArcPad Tools is an extension available for ArcView 3.X and ArcView 
8.X users.  You cannot create unique value legends from within 
ArcPad.    
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9. Now click on the Polygon Style tab.   Click in the Fill Color box.  A new 

dialog appears.  Change the fill color to yellow.  After clicking on the 
color desired, click OK.   Check the box next to Fill Polygons.  Your 
screen should look similar to the one given below. 
 
NOTE:  If you check Save As Global Default, these parameters will 
become your default settings for all polygon features.  

 

           
 
 

10. Click OK to close the Layer Properties dialog.  Your building features 
are now displayed using the new yellow symbol you just assigned. 

 
11. From the Layer Properties dialog, change the symbology of the 

Fencing layer using the Line Style tab. 
 

a. Style – Solid 
b. Width – 1 
c. Color - Green 

 
12. From the Layer Properties dialog, change the symbology for the 

Parking layer using the Polygon Style tab. 
 

a. Outline Style – dash 
b. Outline Width – 2 
c. Outline Color – Black 
d. Ensure the Fill Polygons box is unchecked 
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13. From the Layer Properties dialog, change the symbology for the Signs 

layer using the Point Style tab. 
 

a. Outline Color – Black 
b. Fill Points - Checked 
c. Fill Color – Light Blue 
d. Size – 4 

 
14. From the Layer Properties dialog, change the symbology of the 

trails.shp layer using the Line Style tab. 
 

a. Style – Solid 
b. Width – 2 
c. Color – Red 

 
15. Your map should now look similar to the one below. 

 

                   
  
16. Click on the Save Map  button.    Save your map as NCTC.APM 

and store in the \tec7133\nctc folder.   
 

 
 

 PLEASE STOP HERE ! 
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Using ArcPad zoom tools 

 
1. Click on the dropdown arrow next to the Zoom Full Extent  tool and 

select Zoom to Layer.   Now, select the Buildings.shp layer.   This zooms 
you to the extent of this layer.  

 
2. From the same dropdown menu, click once on the Fixed Zoom In tool.     

 
3. Click on the dropdown arrow next to Go Back To Previous Extent   

tool and select Create Bookmark.   In the Name section, type in Field 
Exercise Area and click OK. 

 
NOTE:  This creates an ArcPadBookmarks.apx file.  This file is always 
stored in your \My Documents folder. 
 

4. Click the Zoom Full Extent button . 
 
TIP:  If you image does not redraw correctly, simply click on the Refresh  
button.  This button is located on the far right of the Browse Toolbar. 
 
5. Now go ahead and test the bookmark you just established.   Click again 

on the dropdown arrow next to Go Back To Previous Extent    tool,   
select Zoom to Bookmark and choose Field Exercise Area. 

 
6. Spend a few minutes getting comfortable with the other zoom functions 

available in ArcPad.    Ensure you try the Zoom In  tool.   There is also 
a Pan  tool available from the dropdown arrow next to the Zoom In tool. 

 
 
 

PLEASE STOP HERE! 
 
 
 

 
 
 
 
 
 
 
 
 
 



 6

 
Querying features using ArcPad 
 
1. Use the Identify  tool and click on any feature from the Sign layer.   The 

Signs dialog will open.  The Site Details form page appears. Click on the 
Sign Information tab to see additional attributes for this feature.  

 
NOTE: The attributes for this layer are display ed using forms.  There 
are several ways to create forms for your layers.  Forms are stored in a 
layer definition file (*.apl).   These forms allow you to easily attribute 
your features in the field when collecting data using your GPS  

 
2. Close the Signs dialog. 
 
3. Use the Identify tool and click on any building feature.   Notice there 

are no form pages associated with this layer.   Close the Feature 
Properties dialog for the buildings layers.  

 
4. Click on the Zoom Full Extent  button. 

 
5. Click the Find  button.  In the Find Dialog Box click on the Select Layers 

 button. 
 

6. The Field Browser dialog appears.  Select Buildings.shp and click OK.   
 

                                        
 

NOTE:   In this example, we don’t have to specify a field since the 
attribute we are searching for is contained in the first field.  The first 
field in the layer is the default setting.  To specify another field, you 
click the + sign next to the layer name and select the field you want to 
use. 

 
 
 
 
 



 7

7. In the Find section type in aldo.  See example below. Now click the 
Search  button.   

                         
 

8. The feature record that contains aldo is displayed in the lower portion of 
the dialog.  Click on the record to select it and then click the Go To  
tool.  The dialog will automatically close and the selected feature is 
labeled in the display.  

 
9. To clear the selected feature, just click the Clear Selected  button. 

 
10. Now use the Find  tool again and using the Buildings.shp layer, locate 

the Rachel Carson Lodge.    
 

TIP:  You don’t have to enter the whole text string in order for ArcPad to 
find this attribute value. 

 
PLEASE DO NOT CLEAR THE SELECTED FEATURE! 

 
11. Let’s assign a hyperlink to features in the Buildings.shp layer.  Click on the 

Layers  button.  Now, select the Buildings.shp layer and click the Layer 
Properties  button. 

 
12. Scroll to the right and click the Hyperlink tab.   Specify the Hyperlink field 

to be PHOTO and click OK.    Close the Layers dialog.  We have just 
assigned a hyperlink field for the Buildings.shp layer.   The PHOTO field 
contains the name of the image to be displayed when the hyperlink tool is 
used. 

 
NOTE:  ArcPad only supports *.bmp, *.jpg and *sid image formats. 

 
13. Click on the dropdown box next to the Identify  tool and select the 

Hyperlink  tool.   Click on the Rachel Carson Lodge (highlighted a nd 
labeled on your map).  An image of this building appears.   Close Internet 
Explorer when finished viewing the image.  Clear the selected feature.  
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Using Measuring Tools in ArcPad 
 

1. Click on the arrow next to the Tools  button and select Options.  
Scroll to the right and click on the Display tab.  Change the Display Units 
to Statute (US Units) and click OK.  

 

                        
 

 
 

2. Zoom to the full extent of your map.  Now activate the Zoom In  tool.  
Zoom to the field that lies north of the main campus by clicking and 
holding down the left mouse button.  Drag and release when the area   is 
defined. 
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3. Click on the dropdown box next to the Hyperlink  tool and select the 
Measure  tool.  You will delineate this field to calculate the area.   
Double click to enter a point and continue entering points until the area is 
delineated.  Return to the point of origin and click on the Measure  tool 
again.  A dialog appears with the measurement information. 

 
What is the acreage?________________________. 

 
4. Now use the Freehand Measure  tool on the same area.  Simply click 

and hold while delineating the field.  Compare these results with the acres 
obtained using the Measure  tool. 

 
Which method is probably more accurate? _______________  

 
5. Experiment with the Radial Measure  tool.  

 
Do you see any applications for this tool?____________    

  
 

6. Use the Measure  tool and determine the walking distance from the 
Instructional East building to the Commons building. 

 
What is the walking distance (distance along)?________( in meters) 
How about as the crow flies (direct distance)?________( in meters) 
 
TIP:  You need to change the display options to metric.  Remember 
how this is done? 

 
7. If time permits, use the supplied ArcPad Toolbar reference sheets and 

experiment with some other ArcPad functions not covered in this exercise.   
 
 

 
  
 
 
 

 



 
 

Section 3 
 

 
 

Preparing GIS Data for ArcPad 
 

 
 
 
Section 3 Objectives:   
 

At the end of this section, you will be able to:  
 

 
o Prepare GIS data for use in ArcPad utilizing ArcPad Tools 

for ArcGIS 
 
o Transfer files to your handheld device using ActiveSync  

 
o Create MrSID files from imagery using ArcToolbox 
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Preparing GIS Data for ArcPad 
 
In this exercise you will learn how to use ArcPad Tools for ArcGIS.   This 
extension allows you to easily prepare your GIS data for use in ArcPad.  
 
NOTE:  This exercise was developed using ArcView 8.3 (SP3) and ArcPad 6.0.2. 
 
 
Using ArcPad Tools for ArcGIS 
 

1. Start ArcMap.  
 
2. Open the Cortez map document (cortez.mxd) which is located in the 

\TEC7133\cortez folder.    
 

3. From the View menu, select Toolbars tab and put a check next to 
ArcPad.   This loads the ArcPad Tools for ArcGIS toolbar.  Dock the 
toolbar if desired. 

        
 

4. Click on the Get Data for ArcPad  button. 
 
5. In the Get Data for ArcPad dialog, click on Select All.   This checks all 

of the layers in your map document.    
 

  
 

6. Click Next. 
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7. Click on the folder icon to change the path of where the new folder is 
going to be created.   Specify \TEC7133\Cortez as the location to store 
the new folder.    Go ahead and leave the default new folder name 
(DataforArcPad1). 

 

 
 

8. Click Finish.    
 
9. The process will take a few minutes.   The image files are being 

encoded to the MrSid format.  Once the process is finished a report 
window will appear. 

 

 
 
10. Notice the Symbol Fonts.   The ESRI Default Marker symbol font is 

being used.   Click OK to dismiss the report window. 
 
11. Close ArcMap and save your changes.   Congratulations!  Your GIS 

data is now ready to be put into your handheld device and used with 
ArcPad. 

 
PLEASE STOP HERE ! 
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Transferring files to your handheld device  
 
The primary software used to connect Windows CE devices to your PC is called 
ActiveSync.   There are 2 ways to setup a connection between your handheld 
device and your PC.  One method is to setup a partnership so your will 
automatically synchronize the data with your PC.   Another method is to simply 
establish a guest relationship.   A guest relationship only lasts as long as the two 
computers are connected.   You can copy, move, drag and drop files back and 
forth between your mobile device and your PC.  It is highly recommended to use 
the guest method. 
 
NOTE:  This exercise was developed using ActiveSync version 3.7  
 

1. Put your mobile device onto the cradle. 
 
2. ActiveSync should automatically detect your device.  If not, take device 

off the cradle and try again.    
 

3. Check No when asked to setup a partnership.  
 

 
 
 
 

4. Click Next. 
 
 
 
 
 

 
 
 
 



 4

5. You are now connected as a Guest.   Your screen should match the 
example below. 

 

 
 

6. Click on the Explore  button. 
 
7. Double click on My Pocket PC (iPAQ) or My Computer (GeoCE). 

 
8. Double click on the \My Documents folder. 

 
NOTE:  Trimble GeoCE users, double click on Disk and then \My Documents.   
This will store you files on the device’s hard disk.  
 
9. From the File menu, choose New Folder. 
 
10. Type Cortez for the name of the new folder. 

 
11. Double click on the Cortez folder. 

 
12. Launch Windows Explorer (Start Menu… Programs… .Windows 

Explorer). 
 

13. Navigate to the \TEC7133\Cortez\DataforArcPad1 folder. 
 

14. From the Edit menu, choose Select All. 
 

15. From the Edit menu , choose Copy. 
 

16. Close or minimize Windows Explorer and return to the Mobile Device 
Explorer window. 

 
17. From the Edit menu, choose Paste. 
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18. Click OK if warned that some files may need to be converted.   
 

   
 

19. The files are transferred to your mobile device.  The transfer may take 
a few minutes. 

 

    
 
 

20. Congratulations you have just transferred your GIS data to your 
handheld device! 

 
 
 

 
 

PLEASE STOP HERE ! 
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Opening an ArcPad map file on your mobile device 
 
1. Remove your mobile device from the cradle. 
 
2. Launch ArcPad. 

 
3. From the Main Toolbar, click the Open Map  button.   Navigate to the 

folder named \My Documents\Cortez and tap the arcpad.apm file.    
 

4. The ArcPad map opens.   Ensure the four files your prepared using 
ArcPad Tools for ArcGIS are present in your map.   

 
NOTE:  GeoCE users, you may need to tap the Refresh  button in order 
for the image files to be displayed. 

 
5. Identify and list the discrepancies between the look of the ArcPad map file 

and the original ArcMap map document. 
 
 
Challenge Topics 
 

1. Change the point symbol for NTC so it matches the symbol used in 
ArcMap.   Why wasn’t the same symbol used for this feature? 

 
2. Change the label for the NTC layer from “BLM National Training Center” to 

“NTC”.   Ensure this label is automatically turned off when zoomed in at a 
display scale of less than 1:10000. 

 
3. Create a label for Cortez Park.  Use the same size and font as the “NTC” 

label.  Ensure this label is automatically turned off when zoomed in at a 
display scale of less than 1:10000 

 
 

EXTRA CREDIT 
 
Create a “new map” and add the four layers you just prepared for use in ArcPad.  
Notice the warning regarding “missing spatial reference” information for these 2 
image files.   Assign spatial reference information for these 2 files so this warning 
doesn’t appear when you add these layers. 
 
 
 
 

PLEASE STOP HERE ! 
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Creating MrSID files from Imagery using ArcToolbox 

 
ArcPad displays imagery best if your files are in the MrSID format.   All users of 
ArcGIS can encode individual, uncompressed rasters smaller than 50 MB.  The 
50 MB size rule will be evaluated as follows: Image Width * Image Height * 
Number of Bands cannot be greater than 50 million. 
 
If you purchase the extension from Lizard Tech, then your limit is 500 MB with 
the added ability to mosaic images. 
 
In this exercise you will take a B&W DOQQ which is currently in the TIF file 
format and encode into the MrSID format using ArcToolbox.  This method is 
preferable to ArcPad Tools when you have multiple adjacent images and/or you 
exceed file size thresholds.   This method allows you to set the compression level 
desired. 
 

1. Open up ArcToolbox. 
 
2. Click on Conversion Tools… .Export from Raster… Raster to MrSID.  

 
3. Click on the folder button just to the right of Input Raster.    

 
4. Navigate to the \TEC7133\Cortez folder.    

 
5. Select the glendale_ne.tif file (file size is ~49 Mb).   

 
6. Change the compression ratio to 20. 

 
7. Specify \TEC7133\Cortez as the folder and type glendale20 for the 

Output Raster name.    
 

8. Click OK.  The encoding takes a few minutes. 
 

9. Congratulations you have successfully created a MrSID file from a 
DOQ that was in TIF format! 

 
NOTE:  Batch processing can only be done with the MrSID extension. 

 
Challenge Topic 
 
Encode the same file at a compression ratio of 100:1 and name it 
glendale100.sid.   What are the file sizes for the glendale100.sid file and 
glendale20.sid?  Transfer these two files to your handheld device and compare 
any differences between their display times and image quality.     
 



 
 

Section 4 
 

 
 

Using an Applet to Create Basic Forms 
 

 
 
 
Section 4 Objectives:   
 

At the end of this section, you will be able to:  
 

 
o Set ArcPad path options 
 
o Create new layers in ArcPad 

 
o Install an applet 

 
o Create a form using the ArcPad Form Creation Wizard 

 
 



 1

Using an Applet to Create Basic Forms 
 
 
In this section you will learn how to set path options, create new layers, install an 
applet and build a basic form for data collection.   The forms are created using an 
applet called the ArcPad Form Creation Wizard.     
 
Set your path options 
 
To streamline adding data you can specify the location of your maps and data 
from the Paths tab in the ArcPad Options dialog.   This is also where you specify 
the location that ArcPad looks for system files, applets and/or extensions.  
 

1. Open ArcPad. 
 
2. Tap the Tools  button. 
 
3. Scroll over and tap the Paths tab. 

 
4. In the Default Maps & Data Path section, click on the folder and specify 

the path to your Cortez data.  See iPAQ Pocket PC example below.  
 

NOTE:  GeoCE users should specify: \Disk\My Documents\Cortez 
 

   
 

5. Take note of the Applets File Path section.   You will be copying applet 
files to this location later in this section.  
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Create a new layer 
 

1. On your handheld device, open the ArcPad.apm file located in your \My 
Documents\Cortez folder. 

 
2. From the drop down next to the Open Map icon, select New Layer. 

 
3. Ensure Point is selected in the Type section and tap on the Add Field  

button to create a new field. 
 

4. Enter FEATURE for the name and assign 15 for the length.   Ensure Text 
is checked for the type of field to be added.   See example below.  Tap OK 
when finished setting the field parameters. 

 

      
 

5. Add a Text field named NOTES with a length of 20. 
 
6. Add a Date field named DATE. 

 
7. Add a Text field named TECH with a length of 20. 

 
8. Add a True/False field named WAAS. 

 
9. Add a Numeric field named QUALITY with a length of 2, and a precision of 

0. 
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10. When finished adding all of the above fields your screen should match the 
example below.   

 

                                 
 

11. Tap OK in the New Shapefile dialog and navigate to the \My 
Documents\Cortez folder and assign the name structures.   Tap Save. 

 
12. Create a new Polyline layer named Trails.   Use the same fields and 

parameters as above but delete the FEATURE field and add a field named 
SURFACE.   The SURFACE field should be a Text field with a length of 2.  
Store this layer in the same location as structures.   

 
13. Create a new Polygon layer named Parking.  Use the same fields and 

parameters as above but delete the FEATURE field and add a field named 
SURFACE.   The SURFACE field should be a Text field with a length of 2.  
Store this layer in the same location as structures.   

 
14. Save your map and close ArcPad. 

 
  

 
 
 

 
PLEASE STOP HERE! 
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Install the applet 
 
The ArcPad Form Creation Wizard is available from the ESRI ArcScripts page 
(http://arcscripts.esri.com/).   This applet is provided on your course CD as 
well.      
 
1. Open Windows Explorer.  Navigate to the \TEC7133\applets\form_wizard 

folder. 
 
2. Select the formwizard.apa and formwizard.vbs scripts.   Copy these files 

and paste into the Program Files\ArcPad\Applets folder located on your 
handheld device. 

 
           NOTE:  Path for GeoCE users:  \Disk\Program Files\ArcPad\Applets 
 

3. Launch ArcPad and ensure a new toolbar is added to your interface.     
 
                                         

                                   
 
 

PLEASE STOP HERE! 
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Copy lookup table to handheld device 
 

1. Copy the \TEC7133\Cortez\ptfeats.dbf file from your PC to the Cortez 
folder on your handheld.  This file will be specified as a lookup table in the 
next section when building your form. 

 
Build the form using the Wizard 
 

1. On your handheld device, open the ArcPad.apm file located in Cortez 
folder. 

 
2. Tap the Layer form creation wizard  button. 

 
3. Select structures.shp from the current map and tap OK. 

 
4. Tap the move all fields  button to include all fields on the new form. 

 
5. Your screen should match the example below.  Tap OK when finished. 

 

                                    
 

6. For field number 1, the FEATURE field, put a check next to “This field is a 
required field”.   

 
7. Tap the Pick List tab. 

 
8. Check “Use a DBF table for the pick list”. 

 

9. Click the browse file  button.   Select the ptfeats.dbf file located in the 
Cortez folder. 

 
 
 



 6

 
 

10. Specify Value for the Value field and Type for the Text field.    Tap OK 
when finished specifying the fields.  

 
NOTE: The value field contains the actual value that will be put into the 
database and the text field contains the text that the user sees when using 
the form.   

 

       
 

11. You are now presented with field number 2, the NOTES field. Since we 
are not going to specify a default value, pick list or make this a required 
field, tap OK. 

 
12. For field number 3, the DATE field, check “Use the current date as the 

default”.  Also check “Display this field as read-only”.  Tap OK. 
 

13. For field number 4, the TECH field, type your last name in the default 
value section.   Also make this field read-only.  Tap OK when finished. 
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14. For field number 5, the WAAS field, specify the default value as False if 

setting up the form for the TeleType GPS and specify True if setting up the 
form for the GeoCE.   Tap OK. 

 
15. For field number 6, the QUALITY field, click on the Pick List tab. 

 
16. Check “Enter picks lists manually”. 

 
17. Type 1 in the Value section.  Type 3 or less in the Text section.  Tap Add. 

 
18. Type 2 in the Value section.  Type 6 or less in the Text section. Tap Add. 

 
19. Type 3 in the Value section.  Type No quality rules in the Text section.  

Tap Add. 

                                         
  
20. Tap the General tab.  Specify 2 as the default value.  Tap OK. 
 
21. Click Yes when asked to reload the shapefile using the new form. 
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22. Tap the Layers  tool.   
 
23.  Make the layer editable by putting a check in the edit column for the 

structures.shp layer. 
 
24. Select the Point  tool and click in your map display to add a point 

feature.   Examine and populate your form.   Click OK.   
 

25. On the Edit toolbar, click on the drop down arrow next to the Properties 
button  and select Delete Feature to remove the feature you just 
added.   Click Yes when asked if you want to delete. 

 
26. Create forms for the Trails.shp and Parking.shp layers.   Ensure the 

SURFACE field is at the top of the form and specified as a required field.  
Use a pick list for the this field and assign the following parameters: 

 
        TEXT          VALUE             
 
        Asphalt           A     (specify as the default value) 
        Concrete        C 
        Dirt/gravel      D  
        Grass             G   

             Other              O  
  
 

Use the same field parameters as the structures.shp for all other fields.  
Be sure to test each form! 
 

 
 
 
 



 
 

Section 5 
 

 
 

Planning GPS Data Collection 
 

 
 
 
Section 5 Objectives:   
 

At the end of this section, you will be able to:  
 

o Utilize Trimble’s Planning software for planning GPS data 
collection   
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Planning GPS Data Collection 
 
Trimble has made available free and easy to use GPS planning software.   The 
Trimble Planning software allows you to determine PDOP conditions for GPS 
data collection at any location you choose.   This information is applicabl e to all 
GPS devices, not just Trimble units.   The installation files for the Trimble 
Planning software is provided on the TEC7133 CD-ROM.   You can also 
download this software from a link at the following URL: 
 
http://www.trimble.com/planningsoftware.html 
  
In this exercise you will use the Trimble’s Planning software to plan GPS data 
collection for the local area using today’s date.  
 
 
NOTE:  This exercise was developed using Planning version 2.7. 
 
 
Step 1- Load Updated Almanac File 
 
1. First we need to download the latest almanac file from Trimble.  For this 

exercise we will utilize an almanac provided by Trimble on the web.   Open 
Internet Explorer and navigate to the following URL:  
 

http://www.trimble.com/gpsdataresources.html 
 

NOTE:  If you have a Trimble GPS, you could use one of your current SSF 
files instead of going to the web. 

 
2. Click on Current Ephemeris Data.   Select Save Target As.  Navigate to the 

d:\tec7133\almanac folder and change the name of the file to currentdate.ssf.   
Click Save.  
 

NOTE:  Changing the name is optional.  However, this is good file 
management.  Almanac files become outdated and are generally good for 
only about 30 days.  Therefore, by using the current date as the file name, 
you now know when you downloaded the almanac from Trimble. 

 
3. Open the Trimble Planning software (Start>>Programs>>Trimble 

Office>>Utilities>>Planning). 
 

4. We need to clear the existing almanac file.  From the Almanac menu, choose 
Clear.  Select Yes when asked if you really want to clear the almanac file.    
 

5. From the Almanac menu, choose Import and click SSF.  
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6. Navigate the d:\tec7133\almanac folder and select currentdate.ssf.   Click 

Open.   Click OK to dismiss the Planning dialog that reports the number of 
imported satellites.  

 

    
 
 
7. You now need to save this almanac into the Trimble Total Control format.   

From the Almanac menu, choose Save.   Name the file currentdate.alm and 
store in same folder as above (d:\tec7133\almanac). 

 
8. Now you can load this new almanac into Trimble Planning.  From the 

Almanac menu, choose Load.   Specify the almanac file you just saved in the 
previous step.   

 
 
Step 2 – Assign GPS Data Collection Parameters 
 
 
1. From the File menu, choose Station.   The Station Editor dialog appears. 

 
2. Click the City button.  Now select Phoenix, AZ from the list of cities and click 

Select.    
 
3. Click on the Time Zone button and apply the correct local time. 
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4. Since you will only be collecting GPS data today between 8am and 5pm, 

ensure the following parameters are entered into the Time section of the 
dialog. 

 
Start Date:  current date 
Start Time: 08:00 
Duration: 9 
Interval: 10 
 
The Station Editor dialog should be similar to the example below.    
 

               
           

            
5. Click OK when finished. 
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6. Since you will not be using a GPS device that utilizes Glonass satellites, 
uncheck the box next to Glonass. 

 

     
     

 
Step 3 – Examine Results 
 
1. From the Graphs menu, choose Number of Satellites. 
 

How many satellites will be visible at 1:00 pm (13:00)?__________ 
      
2. From the Graphs menu, select DOP and choose DOP – Position. 

 
At what time is PDOP generally the lowest?___________ 
 
What is the approximate PDOP value at 9:00 am (09:00) ?________ 

 
3. From the Lists menu, select DOP Values. 
 

What is the exact PDOP value at 9:00 am (09:00)?________ 
 

4. If you wanted to keep PDOP less than 3, which time of day would you avoid? 
 

____________________________________________________________ 
 

5. From the Graphs menu, select Sky Plot.  
 
Why should you avoid facing north when collecting GPS data?  
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Challenge Exercise 
 
Now that you are familiar with using Trimble Planning software, identify PDOP 
conditions near your office. 
 
Use the following parameters: 
 
Location:  City nearest your office 
Elevation cutoff: 10 degrees 
Start Date:  Any date within 30 days of current almanac file 
Start Time: 08:00 
Duration: 8 
Interval: 10 
Time Zone: Set local time 
 
When is PDOP the lowest?_______________PDOP value________ 
 
When is PDOP the highest?______________PDOP value________ 
 
How many satellites are visible at 12 noon?___________  
 
EXTRA: 
 
You need to collect a nest site along the edge of a steep cliff face.  Therefore, 
satellite visibil ity will be blocked for a portion of the sky.  The area to be 
blocked is the entire SE (90 to 180 azimuth) sky from an elevation of 60 
degrees down to the horizon.  Use the Obstruction Editor to set these 
parameters.    If necessary, access the Help Topics to determine how. 
 
List the range of times that represent the best window of opportunity to collect 
this nest site location? ___________________________ 
 
What is the PDOP during this time frame?______________ 

 

       



 
 

Section 6 
 

 
 

Configuring GPS Devices with ArcPad 
 

 
 
 
Section 6 Objectives:   
 

At the end of this section, you will be able to:  
 

o Configure GPS devices to ArcPad   
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Configuring GPS Devices with ArcPad 
 
 
Since each GPS device may have a unique configuration, there are really no 
standard procedures for configuring GPS devices with ArcPad.   However, an 
outline of the four basic steps are given below:  
 

? ? Determine cables and hardware required for connecting GPS device. 
? ? Connect the GPS device to the mobile device. 
? ? Set the configuration of the GPS device. 
? ? Set the GPS options in Arcpad. 

 
Procedures for configuring several commonly used GPS devices with ArcPad are 
provided below.    

 
 
TeleType GPS –  World Navigator    
 
You do not need to install the TeleType software in order to configure the 
TeleType GPS with ArcPad.   However, if you have a TeleType with WAAS 
capability, you need the Advanced GPS Utility software utility to t urn WAAS on 
and off.   Copy the WaasCE.exe file to your handheld.  Double tap this file to run 
the utility.  This utility allows you to toggle WAAS on and off.  You can also 
change NMEA sentence set output using this utility.  
 
Use the following instructions for configuring the TeleType GPS with ArcPad 
using a Compaq iPAQ Pocket PC mobile device. 
 

1. Connect your GPS device to the iPAQ. 
 
2. Open ArcPad. 

 
3. Tap the Tools  icon to open up the GPS options dialog. 
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4. Select the Protocol tab and ensure the following protocol is set:  

 
Protocol: NMEA 0183 
GPS Datum: WGS84 
 

 

         
      

NOTE:  The TeleType World Navigator always outputs GPS data using 
WGS84. 

 
5. Tap the GPS tab and ensure the following parameters are set. 

 
Port = Com4 
Baud = 4800 
Parity = None 
Data Bits = 8 
Stop Bits = 1 

 

            
 
  

NOTE:  If using the dual expansion pack or are having trouble finding 
correct COM port number, consider using the FindGPS 1.0.5 extension.  
See yellow pages included at end of chapter on using this utility.  
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6. Tap the GPS Position Window    icon.  The following dialog 

appears.  Tap Yes to activate your GPS. 
 

 
 
 

7. Test to see if GPS device is communicating with ArcPad.  Tap the drop 
down arrow just to the right of the GPS Position Window  icon.   
Select GPS Debug. 

 
 
8. If your GPS device is communicating with ArcPad, data (NMEA 

sentence sets) stream across the GPS debug window.   Close the 
debug window by unselecting GPS debug from the dropdown arrow. 

 
 

                  
 
 

9. If the GPS debug window is blank, go back to the options dialog and 
verify your settings.   If the settings are correct, try another COM port. 
You should also check the connection between the GPS device and 
the handheld. 

 
NOTE:  If you get a message stating that the COM port is unavailable, 
soft boot your handheld device and try establishing a connection again.   
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Trimble GeoCE running GPSCorrect 
 

Step 1 - Configure the GPS device 
 

1. Open GPSCorrect (tap F1 along right side of window). 
2. Change the display to Setup. 
3. Tap on Logging Settings. 
4. Turn Log GPS to SSF to ON. 
5. For Data Type, choose SuperCorrect.   This allows you to post-

process data that is collected using real -time such as WAAS. 
 
Step 2 - Configure ArcPad 
 
1. Set the following parameters in the GPS Options dialog. 
 

Protocol Tab 
 

Protocol: Trimble GPSCorrect 
Datum: WGS84 
 
GPS Tab 
 
Port = Com3 
Baud = 9600 
Parity = Odd 
Data Bits = 8 
Stop Bits = 1 

 
 
Hardware for PLGR, Garmin and various Trimble devices 
 
If you are going to connect a PLGR, Trimble, or any Garmin to a Compaq iPAQ 
(models 3100, 3600 and 3700 series) you need to purchase a Compaq RS-232 
serial cable.   This cable costs around $30.  You can obtain this item from  
CDW-G (www.cdwg.com).   The Compaq part number is 236251-B21.  This 
cable is required in addition to the PLGR/Garmin to PC cable.  
 
Please be aware that the cable connection to the iPAQ is not very good.   The 
cable becomes disconnected quite easily.   A solution to the problem is ordering 
a Surveyor’s Window Case from XYZ Works (www.xyzworks.com). 
This case costs around $115.  If you purchase this item you do not need the 
RS-232 serial cable mentioned above. 
 
NOTE:  The Surveyor’s Window Case DOES NOT work with the dual expansion 
pack. 
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Garmin GPSMap76S  
 

1. Configure the GPS device.  Set the serial data format to NMEA.   
From  Main Menu,  choose … .Setup… .Interface… Serial Data Format.     
 
NOTE:  The default setting is Garmin. 

 
2. In ArcPad, set the following parameters in the GPS Options dialog: 
 

Protocol: NMEA 
Datum: WGS84 

 
Port = Com1 
Baud = 4800 
Parity = None 
Data Bits = 8 
Stop Bits = 1 

 
NOTE:  These settings should work with most Garmin GPS devices.   

 
 
 
PLGR +96 
 

1. Configure the GPS device.  Set the serial output on PLGR to Custom. 
Select NMEA as the output.  To change serial output select Setup 
menu.  Move to the 6th page and change Serial to Custom.  Move to 
the next page and change Serial OUT to NMEA.  Move to next page 
and add following NMEA sentence sets:  GGA, GLL, GSA , GSV, and 
VTG. 

 
2. In ArcPad, set the following parameters in the GPS Options dialog: 

 
Protocol: NMEA 
Datum: WGS84  

 
Port = Com1 
Baud = 9600 
Parity = None 
Data Bits = 8 
Stop Bits = 1 
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Trimble Pathfinder Pocket 
 

1. Download Trimble’s Pathfinder Controller software which is free and 
available at:  www.trimble.com/pathfindercontroller.html 

 
2. Open Pathfinder Controller software, ensure Port B is set to COM 1 

and the Protocol is set to TSIP. 
 

3. In ArcPad, set the following parameters in the GPS Options dialog: 
 

Protocol: TSIP 
Datum: WGS84 

 
Port = Com1 
Baud = 9600 
Parity = None 
Data Bits = 8 
Stop Bits = 1 

 
OPTIONAL:   You can use NMEA protocol instead of the Trimble 
proprietary protocol (TSIP).  This protocol must be specified in Pathfinder 
Controller software.  Also, for NMEA settings, check the GGA, VTG, GLL, 
GSA, GSV, RMC, ZDA sentence sets in Pathfinder Controller. 

 
 
GeoExplorer 3 
 

1. Configure GPS device.  From the SYS menu page select Setup tab. 
Select Configurations and then choose COMMS.  Use the following 
settings: 

 
NMEA Output:  Serial Clip 
Port Settings:   

Input Baud Rate: 38400 
 Output Baud Rate: 38400 
 Parity = None 

Data Bits = 8 
Stop Bits = 1 
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2. In ArcPad, set the following parameters in the GPS Options dialog: 
 

Protocol: NMEA 
Datum: WGS84  

 
Port = Com1 
Baud = 38400 
Parity = None 
Data Bits = 8 
Stop Bits = 1 



 
 

Section 7 
 

 
 

Collecting GPS Data with ArcPad 
 

 
 
 
Section 7 Objectives:   
 

At the end of this section, you will be able to:  
 

o Create a new shapefile layer  
 
o Set GPS quality and capture options 
 
o Collect point, line and polygon features in the field using 

ArcPad 
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Collecting GPS Data with ArcPad 
 
Once you have your GPS device configured, you are ready to start collecting 
data in ArcPad using your GPS.   What really makes ArcPad nice, is that since 
you capture data directly into a shapefile, you eliminate the step of  converting the 
raw GPS data into a format compatible with your GIS.   
 
There are several new shapefile types that you may not be familiar with. Here is 
a list of all the shapefile types that can be ceated in ArcPad and a description for 
each.   
 

Shapefile Type Description 
Point 2D point shapefile that only stores X and Y coordinates 
PointZ 3D point shapefile that stores X, Y and Z coordinates 
PointM 2D point shapefile that stores X,Y and M (measure value) 
Polyline 2D polyline shapefile that only stores  X and Y coordinates 
PolylineZ 3D polyline shapefile that stores X, Y and Z coordinates  
PolylineM 2D polyline shapefile that stores X,Y and M (measure value)  
Polygon 2D polgyon shapefile that only stores X and Y coordinates  
PolygonZ 3D polygon shapefile that stores X, Y and Z coordinates 
PolygonM 2D polygon shapefile that stores X,Y and M (measure value) 
 
 
Creating a layer (shapefile) in ArcPad 
 
In this exercise you will create a new habitat layer for use at NCTC.  
 

1. Open ArcPad. 
 
2. Tap the dropdown arrow to the right of the Open Map  button. 
 
3. Tap New Layer. 

 
4. Choose the polygon shapefile from the Type dropdown list. 
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5. Tap the  +  button to open the Field dialog box.  
 

 
 
6. Define the first field for you new shapefile’s table.  Enter GPSDATE in 

the Name section.  Check Date for field type.  Click OK when finished. 
 

     
 

 
7. Tap the  +  button to open the Field dialog box.  Use the following 

parameters to define the second field.  Click OK when finished. 
 

NAME:  GPSTECH 
TYPE: TEXT 
LENGTH:  25 
 

8. Tap the  +  button to open the Field dialog box.  Use the following 
parameters to define the third field.   Click OK when finished. 

 
 

NAME:  FEATURE 
TYPE: TEXT 
LENGTH: 25 
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9. Tap the  +  button to open the Field dialog box.  Use the following 

parameters to define the fourth field.   Click OK when finished. 
 

NAME:  AREA 
TYPE: NUMERIC 
LENGTH: 10 
PRECISION: 2 
 

10. The New Shapefile dialog box should match the example below.  Click 
OK when finished. 

 
 

 
 

 
11. You will be presented with a dialog box.   Store the file in the TEC7133 

folder and name the file HABITAT. 
 

 
12. Tap the Layers button.   Notice the new layer is already in edit mode.  
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13. Tap the Projection Information  button. 
 

 
 
14. ArcPad defaults to the Geographic Coordinate System referenced to 

the WGS84 datum (GSC_WGS_1984). 
 

NOTE:  If you would have added a layer that had a *.prj file associated 
with it before creating this new layer, then ArcPad would use the 
projection associated with that layer.    

 
 

 
 

15. Tap the Define Projection  button.  Navigate to the My 
Documents\prjs folder and select the NAD83UTM18.prj file. 

 
16. Tap the Projection Information  button to verify the new projection 

settings.  
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Setting GPS Quality and Capture Options 

 
Another nice feature of ArcPad is the ability to specify quality and capture options 
that meet your projects accuracy requirements.   In this exercise, you will set 
GPS data capture and quality options before collecting habitat features on NCTC 
with ArcPad and a GPS device. 
 

1. Tap the Tools button to open the ArcPad Options dialog. 
 

         
 

2. Tap the Quality tab.   Put a check next to Compulsory Warnings. Now, 
set the Maximum PDOP to a value of 6.  Your dialog should match the 
example below.  

 
NOTE:   By checking compulsory warnings, you cannot collect GPS 
data that exceeds a PDOP value of 6.  If you had checked non-
compulsory, then you would be warned if PDOP was above 6 but stil 
having the option to continue collecting data.  
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3. Tap the Capture tab.  Put a check in Enable Averaging.   For the 
number of positions to average enter 30 for Points and 10 for Vertices.  
Leave the default setting of 1 for the Streaming Vertices Interval. 

 
NOTE:  An average position usually is more accurate than one single 
position.   

 
 

         
 
 
4. Tap the Alerts page.   By default all warnings are checked.  Extend the 

first column so you read all of the alerts.  Tap the column divider, hold 
and drag your stylus to the right to extend the column so you can read 
all of the various alerts.   Click OK when finished. 

 
OPTIONAL:   Uncheck the audio sound for the No Current Position 
alert.   This alert can be rather annoying when waiting for the GPS to 
startup and obtain a positional fix.    

 

               
 
5. You are now ready to begin collecting data.  
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Steps for Creating Point Features with a GPS 
 

1. Select a point layer for editing in the Layers dialog. 
 
2. Activate your GPS.    

 
3. Monitor the GPS Position Window until you have a positional fix that is 

within the quality options you have specified for the project.  
 

4. Tap the GPS Point  button on the on the Edit/Drawing toolbar to 
create a point feature. 

 
5. Type in the attributes for the new feature. 

 
Methods for Capturing Line and Polygon Features  
 
There are two methods that can be used when capturing vertices for line and 
polygon features. 
 

? ? Add GPS Vertex    
? ? Add GPS Vertices Continuously  
 

NOTE:  The Add GPS Vertex method allows you to collect each vertex 
individually and is much more accurate especially when averaging is used. The 
Add GPS Vertices Continuously method is more suited for mapping trails and 
roads from a moving vehicle. 

 
Steps for Creating Line Features with a GPS 
 

1. Select a line layer for editing in the Layers dialog. 
 
2. Activate your GPS.    

 
3. Monitor the GPS Position Window until you have a positional fix that is 

within the quality options you have specified for the project.  
 
4. Tap the Add Vertex  button to capture a single vertex or tap the Add 

GPS Vertex Continuously  button to capture streaming vertices. 
 

5. Tap the Polyline button when you are ready to complete the capture 
of the polygon feature.   

 
6. Type in the attributes for the new feature. 

 
TIP:  You can also record a point feature while recording a line feature.  
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Steps for Creating Polygon Features with a GPS  
 

1. Select a polygon layer for editing in the Layers dialog. 
 
2. Activate your GPS. 

 
3. Monitor the GPS Position Window until you have a positional fix that is 

within the quality options you have specified for the project.  
 
4. Tap the Polygon  button to start capturing a polygon feature. 
 
5. Tap the Add Vertex  button to capture a single vertex or tap the Add 

GPS Vertex Continuously  button to capture streaming vertices. 
 

6. Tap the Polygon  button when you are ready to complete the 
capture of the polygon feature.  The last vertex will automatically 
connect to your first vertex and close the polygon.  

 
7. Type in the attributes for the new feature. 

 
 

TIP:  You can have one point, one line and one polygon layer all selected for 
editing in the Layers dialog. 
 
 

Creating a Tracklog Shapefile in ArcPad 
 
ArcPad stores a tracklog in shapefile format.   The points created are displayed 
in the map as a red line.  The GPS Tracklog are always captured in latitude and 
longitude using WGS84.  The tracklog is projected on the fly to the current 
projection of the ArcPad map.   You cannot attribute this shapefile, however, 
numerous coordinate and data quality attributes are automatically collected for 
each point. 
 
When using the Add Layer tool to add the tracklog shapfile, ArcPad displays the 
the tracklog as points.  In this case, it does not perform on-the-fly projection of 
the tracklog’s point data. 
 
To toggle the tracklog on and off, choose GPS Tracklog from the dropdown to 
the right of the GPS Position Window   icon. 
 
Properties for the tracklog can be set as well.  Tap the Layers button to open the 
Layers dialog.  Select the GPS Tracklog  layer and tap the Layer Properties 
button. 



 
 

Section 8 
 

 
 

Metadata 
 

 
 
 
Section 8 Objectives:   
 

At the end of this section, you will be able to:  
 

 
o Create a metadata template   
 
o Import a metadata template 

 
o Populate metadata records  
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Metadata 
 
 
ArcCatalog provides wonderful tools for creating metadata.   What is metadata?  
Simply put, metadata is “data about data”.   All federal agencies are required to 
produce metadata for their spatial data layers.   In this section you learn how to 
create a metadata template, import the template and populate critical fields for 
the GPS data you previously collected in the field.     
 
Create a metadata template  
 

1. Open ArcCatalog (Start… Programs… ArcGIS… ArcCatalog). 
 
2. Click on the Connect to Folder  button. 

 
3. Navigate to the \TEC7133\Cortez folder and click OK. 

 
4. From the Tools menu, choose Options. 

 
5. Click on the Metadata tab.   Ensure the Creating Metadata and 

Updating Metadata sections are checked so the creation and updates 
of metadata are performed automatically.  Also, ensure the FGDC 
ESRI stylesheet and FGDC Editor are specified in the appropriate 
sections.   Click OK when finished. 
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6. Click on the plus sign  next to the \TEC7133\Cortez folder to expand 
this folders contents in the catalog tree. 

 
7. We are going to use the structures.shp file to create our template.   

Select this file in the catalog tree.   NOTE:  Any layer file can be used 
to create the template. 

 
8. Click on the Metadata tab.   Now, since ArcCatalog has been set to 

automatically create metadata, the program will extract as much 
information as it can from the shapefile and generate a metadata file.  
The metadata file is an XML (Extensible Markup Language) file and 
placed in the same folder as the shapefile.    

 

 
 

9. Click on the Spatial tab in the display window.   Notice the horizontal 
coordinate system and bounding coordinates are automatically 
determined for you.    

 
10. Click on the Attributes tab.  Notice the list of attributes (field names).  

Click on the Feature attribute.   It expands and displays the field type 
parameters that you previously assigned in ArcPad.  

 

     
 

11. Now we are going to enter some general information that will always 
remain the same and be included in any metadata you generate for 
your ArcPad files.  Click on the Edit Metadata  button to open the 
Metadata Editor. 
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12. After a few seconds, the Metadata Editor dialog appears.  Notice the 
seven mains sections appear in across the top with the Identification 
section appearing in bold text.   This is the currently selected section 
and this sections contents appear below.   Notice there are 10 tabs of 
information for this section.   Click on the Contact tab. 

 

               
 
13. Now click on the Details button.   The following dialog opens.  Use this 

form to enter your contact information.  Type your name in the Person 
section.  Enter your Organization and Position information.   

 
NOTE:  You can choose to make your organization the primary 
contact. 
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14. Enter your work hours in the Hours of Service section. 
 
15. Enter any additional Contact Instructions. 

 
16. In Contact Voice, enter your phone number.   
 

NOTE: If you have more than one phone number, simply click the add 
 button to add another number.  This add function works the same for 

all other fields that may have multiple entries.  
 
17. In Contact Fax, enter your fax number. 
 
18. In Contact Email, enter your email address. 

 
19. If applicable, populate the Contact TDD/TTY information. 

 
20. Click the Address tab. 
 
21. Select the appropriate Address Type. 

 
22. Enter the additional address information (City, State, Postal Code, 

Country). 
 

23. Click OK when finished. 
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24. The contact information you just entered needs to appear in 3 other 

locations throughout the metadata form.  Unfortunately you will need to 
add this information to these other 3 locations.  However, once this is 
accomplished and you save this file and export it out as a template, 
you will never have to enter this information again!   Navigate to the 
following Sections/Tabs and enter your contact information again:  

 
Data Quality / Process Step 
Distribution / Distributor  
Metadata Reference / General 
 
NOTE:  You do not have to populate all contact information locations 
during class.  Try to populate at least 2 sections so you become 
familiar with the Metadata Editor interface. 

 
25. Here is a list of other fields that are likely candidates for inclusion in 

your metadata template file.   Enter these if applicable and as time 
permits for this exercise. 

 
Identification / General  / Access Constraints 
 
Identification / General  / Use Constraints  

 
Identification / Citation / Details / Originator  
 
Distribution / General / Distribution Liability  
 
Example liability statement: 
 
This data set was constructed for use by NCTC staff only. 
The U.S. Fish and Wildlife Service (USFWS) shall not be  
held liable for improper or incorrect use of the data  
described and/or contained herein.  These data are not 
legal documents and are not intended to be used as such. 
It is the responsibility of the user to use the data  
appropriately and consistently recognizing its limitations.  
The USFWS gives no warranty, expressed or implied, as to 
the accuracy, reliability, or completeness of these data.  It  
is strongly recommended that these data be acquired 
directly from the USFWS and not through other sources 
which may have changed the data.  This disclaimer applies 
both to individual use of the data and aggregate use with  
other data. 
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26. Click Save when finished entering the form with template information. 
 
27. Change the Stylesheet to FGDC Classic. 

 
28. Scroll through the appropriate sections and examine your contact 

information.  If you desire edits, simply go back into the Metadata 
Editor and make the necessary changes. 

 
29. Once you get the information as you like, click the Export Metadata  

button. 
 

30. Change the Format to FGDC CSDGM (SGML).  
 

31. Click the Browse button and navigate to the \TEC7133\template 
folder.   Assign the name mytemplate.sgml  and click Save. 

 
32. Click OK in the Export Metadata dialog. 

 

               
 

33. Congratulations!  You have just created a metadata template. 
 
 
 
 
 
 
 
 
 

PLEASE STOP HERE! 
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Importing your metadata template  
 
 

1. In the Catalog Tree, select the trails.shp file. 
 
2. Click on the Metadata tab. 

 
3. Click the Import Metadata  button. 

 
4. Click the Browse button and navigate to the template file you created in 

the previous section.  Ensure “Enable automatic update of metadata” is 
checked.   Click OK.  

 
 

        
 

5. Use the FGDC Classic stylesheet and ensure your metadata template 
was successfully imported by looking for completed contact information 
sections. 

 
6. Import your metadata template for the parking.shp layer. 
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METADATA EXERCISE 
 
Use the Metadata Editor and populate the Process Step section for at least one 
of the following shapefiles: 
 
structures.shp 
trails.shp 
parking.shp 
 
This Process Step can be found in the Data Quality section. 
 
The Process Description section should describe the methodologies you used 
in the field to collect the data.   Be prepared to share with the class your process 
description.    This metadata section can be as lengthy or as concise as you 
want.   Some things to consider including in the process description are:  
 
Were there any quality/capture rules established?   
Were the rules ever broken? 
Was averaging used?  If so, how many seconds. 
Was streaming vertices mode used for lines and polygons (if so, what interval 
was used)? 
Was averaging used on vertices? 
How was differential correction performed?  Which base station was used?   
What software packages and versions used? 
What commands or functions were executed in the processing of this file? 
 
Include anything you feel is relevant regarding the process you used to create 
this spatial layer file!    
 
Feel free to complete other metadata sections as time permits. 
 
TIP:  If unsure what to put into a metadata field, simply click the Help  button 
located in the upper right of the Metadata Editor dialog and then click on the field.   
A popup appears describing what information should be contained in the field.  
 
 
 

 



 
 

Section 9 
 

 
 

Creating Custom Forms with ArcPad Studio 
 

 
 
 
Section 9 Objectives:   
 

At the end of this section, you will be able to:  
 

 
o Create a new shapefile using ArcCatalog   
 
o Create a layer definition file using ArcPad Studio  

 
o Assign Vbscript code to an “event” 

 
o Build a custom form for you new shapefile 

 
 



 1

Creating Custom Forms with ArcPad Studio 
 
 
In this exercise you will build a customized form for a new shapefile.  The form   
will allow you to streamline data collection in ArcPad.  Forms are generated in 
ArcPad Studio by creating a layer definition file for your shapefile.  You use 
existing shapefiles to build forms, however, in this exercise we will create a new 
shapefile from scratch using ArcCatalog.     
 
 
Step 1 – Create new shapefile using ArcCatalog 
 

1. Open ArcCatalog. 
 

2. Navigate to the D:\tec7133\forms_exercise folder. 
 

3. Right click on the forms_exercise folder and select New and choose 
Shapefile. 

 
4. Assign the name structures to the shapefile and then click on the Edit 

coordinate system button. 
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5. From the Spatial Reference Properties dialog, click the Select button. 
 

      
  

6. Double click on the Projected Coordinate Systems.  Continue 
navigating through the folders by double clicking on  UTM and NAD 
1983.  Select the NAD 1983 UTM Zone 18N.prj file and click Add.   
This assigns a projection file to the new shapefile you are creating.      
Click OK when finished. 

 
7. Your screen should match the example below.  Click OK to close the 

Create New Shapefile dialog. 
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8. Your new shapefile now appears in ArcCatalog.  Right mouse click on 
the structures.shp file and select Properties. 

 
 

 
 
 

9. At the top of the Shapefile Properties dialog, click on the Fields tab.      
You screen should match the example below. 
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10. Click in the empty row underneath ID to assign a new field name.   
Type in the following field name:  gpsdate 

 
11. Hit ENTER or click in the same row under the Data Type column.  

Click on the down arrow and select Date from the list of data types. 
 

12. Using the same procedures as above, add 3 more fields using the 
following parameters: 

 
Field Name  Data Type  Precision* 
gpstech   text   50 
feature   text   50 
condition   short integer  2 
 
 
*Precision values can be edited in the Field Properties section. 
 

13. Your screen should match the example below.  Click OK when 
finished.   
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Step 2 – Create Layer Definition File using ArcPad Studio 
 
 

1. Double click on the ArcPad Studio icon to launch the program. 
 
2. From the File menu, select New and choose Layer Definition. 

 
3. Navigate to d:\tec7133\forms_exercise folder and select the 

structures.shp file and click Open.   This is the shapefile you just 
created in ArcCatalog.   

 
4. Double click on <LAYER>. 

 
5. Assign the name Structures for this layer.    The name you enter will 

be the name that appears in the ArcPad Layer Properties dialog. 
 

6. Click on the Events tab.    
 

7. We want to write some Vbscript code that automatically puts this layer 
in edit mode and shows the Draw toolbar whenever we add this layer 
to ArcPad.   This will save us a few steps when collecting data in the 
field.   Scroll down and then double click on the onopen event. 

 
8. Enter the following code: 

 
     Layer.Editable=True 

Application.Toolbars("Draw").Visible = True 
 
 

9. Your screen should match the example below.  Click OK. 
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10. Click on the Forms  button. 
 

  
 

11. From the Forms dialog, click EDITFORM. 
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12. From the Edit Form dialog, click the Form menu and select Form 

Properties. 
 

         
 
 

13. In the Caption section, type Structures.  Click OK when finished.   
 

       
 
 
14. Notice the name of the form dialog is now called Structures.    
 
15. From the Structures form, click on the Page menu and select Page 

Properties.   The Page Properties dialog appears. 
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16. In the Caption section, type Feature Info.  Click OK when finished.  

 

        
 

17. Notice the change on the Structures form.   You are now ready to add 
some controls to the form and assign them to fields in our shapefile.  
The first field in our shapefile that we will add a control for is gpsdate. 

 
 
 

 
PLEASE STOP HERE! 

 
 
 
 

 
18. Click and hold on the DATETIME  control and drag it to the top 

center section of the Structures form and release.   
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19. The Control Properties dialog appears.  Type dtGpsDate in the Name 
section.    

 
NOTE:  You could name this control anything you want.  However, if 
you begin using Vbscript, then you would access the control in the 
script using the name assigned here.  Therefore, following some 
standardization in naming controls and variables is wise.   A common 
naming convention used by programmer’s is Hungarian notation. 

 
20. Click on the drop down arrow to the right of Field and select the 

GPSDATE field. 
 

21. Put check marks in the Required and Read Only sections. Your form 
should be similar to the example below (the X and Y may not match, 
depending on where you positioned the form). 

 
NOTE:  By checking the “required” attribute for the control, the user is 
required to enter a value for this field on the form.   By checking the 
“read only” attribute for the control, the control is disabled on the form.  

 

 
  

22. Now, click on the Values tab.   In the Default Value section, type the 
word Date.   Click OK when finished.    

 
NOTE:  By putting the date function in the default value section, the 
current date is automatically populated into the form when a new point 
feature is created.    
 
 

PLEASE STOP HERE! 
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23. Position the control near the right edge of the form by moving it (click, 

hold & drag).      
 
24. For the next field, gpstech, we will add a COMBOBOX to our form.  A 

Combo Box allows the user to choose from a list of values.  A lookup 
table (techlist.dbf) has already been created for you and will be used to 

populate the combo box.   Click and hold on the COMBOBOX   
control and drag it underneath the dtGpsDate control and release.  

 
TIP:  If you hold your mouse over a control icon, the name of the 
control appears.  

 
25. The Control Properties dialog appears.  Type cbGpsTech in the Name 

section.    
 
26. Click on the drop down arrow to the right of Field and select the 

GPSTECH field. 
 

27. Put a check mark in the Required section.  Your form should be 
similar to the example below (the X and Y may not match, depending 
on where you positioned the form). 

 

        
 

28. Now let’s assign a lookup table which will be used to populate the drop 
down list in this combo box.  Click on the List Values tab.   Click the 
Browse button and select the techlist.dbf file.  This is located in the 
d:\tec7133\forms_exercise folder.   It should default to this folder.  Click 
Open once it is selected.   
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29. In the Values Field section, select Name. 
 
30. In the Text Field section, select Name. 

 
31. At the bottom of the Control Properties dialog, put a check next to the 

Sort attribute.  Your form should match the example below.   Click OK 
when finished. 

 
NOTE:  By checking the “sort” attribute for the control, the list of items 
that appear in the drop down box on the form are automatically sorted 
alphabetically. 

 
 

       
 

 
32. Position the control near the right edge of the form by moving it (click, 

hold & drag).      
 
33. Now we need to assign a Combo Box for the feature field.  Click and 

hold on the COMBOBOX   control and drag it underneath the 
cbGpsTech control and release. 

 
34. The Control Properties dialog appears.  Type cbFeatures in the Name 

section.    
 
35. Click on the drop down arrow to the right of Field and select the 

FEATURE field. 
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36. Put a check mark in the Required section.  Your form should be 
similar to the example below (the X and Y may not match, depending 
on where you positioned the form). 

 
      
 

      
 
 

 
37. Now let’s assign a lookup table for this combo box.  This table has 

already been created for you as well and contains a list of structural 
features on NCTC.  Now click on the List Values tab.   Click the 
Browse button and select the features.dbf file.  This is located in the 
d:\tec7133\forms_exercise folder.   It should default to this folder.  Click 
Open once it is selected.  

  
38. In the Values Field section, select Structures. 
 
39. In the Text Field section, select Structures. 
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40. At the bottom of the Control Properties dialog, put a check next to the 

Sort attribute.  Your form should match the example below.   Click OK 
when finished. 

     

      
 

 
41. Position the control near the right edge of the form by moving it (click, 

hold & drag).     
  
42. Now we need to assign a Combo Box for the condition field.  Click and 

hold on the COMBOBOX   control and drag it underneath the 
cbFeatures control and release. 

 
43. The Control Properties dialog appears.  Type cbCondition in the 

Name section.    
 
44. Click on the drop down arrow to the right of Field and select  the 

CONDITION field. 
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45. Put a check mark in the Required section.  Your form should be 
similar to the example below (the X and Y may not match, depending 
on where you positioned the form). 

        

      
 

  
46. Now click on the List Values tab.   For this combo box, instead of 

using a lookup table, we will assign and store the values in the form 
(layer definition file) we are creating.    

 
47. In the Values stored with form section, for Value type 1 and for Text 

type Good.   Click Add when finished.   
 

48. In the Values stored with form section, for Value type 2 and for Text 
type Needs Repair.   Click Add when finished.    

 
49. Check Limit to list at the bottom of the Control Properties dialog.    

 
NOTE:  By checking the “limit to list” attribute for this control, t he 
combo box can display the text values you specified above. 
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50. Your screen should match the example below.  Click OK when 
finished. 

 

     
 

 
51. Position the control near the right edge of the form by moving it (click, 

hold & drag).   Your form should be similar to the example given below. 
   

 
 
 
 
 
 

PLEASE STOP HERE! 
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52. Now we need to add labels for the controls so the user knows what 

these controls represent. 
 
53. Click and hold on the LABEL   control and drag it to the left of the 

dtGpsDate control and release. 
 

54. The Control Properties dialog appears.  Type lbGpsDate in the Name 
section.   In the Caption section type Date:.   Also, change the width of 
the control to 25.  Click OK when finished. 

 

                   
 

55. Position the label control on the left side of the dtGpsDate control.  
 

56. Click and hold on the LABEL   control and drag it to the left of the 
cbGpsTech control and release. 

 
57. The Control Properties dialog appears.  Type lbGpsTech in the Name 

section.   In the Caption section type Technician:.   Also, change the 
width of the control to 40.  Click OK when finished. 

 
58. Position the label control on the left side of the cbGpsTech control.  

 
59. Click and hold on the LABEL   control and drag it to the left of the 

cbFeatures control and release. 
 

60. The Control Properties dialog appears.  Type lbFeatures in the Name 
section.   In the Caption section type Structure:.   Also, change the 
width of the control to 40.  Click OK when finished. 
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61. Position the label control on the left side of the cbFeatures control.  
 

62. Click and hold on the LABEL   control and drag it to the left of the 
cbCondition control and release. 

 
63. The Control Properties dialog appears.  Type lbCondition in the Name 

section.   In the Caption section type Condition:.   Also, change the 
width of the control to 40.  Click OK when finished. 

 
64. Position the label control on the left side of the cbCondition control.  

Your form should be similar to the example given below. 
 

     
 

65. Click OK when finished building the form. 
 
66. From the File menu, click Save. 

 
67. From the File menu, click Exit.  You are finished creating the form! 
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Step 3 – Testing Your Form 
 
 

1. Launch ArcPad on your PC.  
 

      
2. Click Add Layer.  Navigate to the d:\tec7133|forms_exercise folder 

and select the structures.shp layer file.  Click OK 
 
                
3. Notice the Structures layer has been automatically put into edit mode 

and the Draw toolbar appears. 
 

  
4. Add a feature anywhere on the display using the Point   tool.   The 

Structures form automatically appears.    
 

                                     
 

5. Use the form to attribute the feature you just added using the combo 
box controls.    

 
6. Ensure the DATE control displays the current date and is automatically 

checked and disabled on the form.    
 

7. Ensure the TECHNICIAN and STRUCTURES combo boxes displays a 
list of values sorted alphabetically.  Select any one value in each.  

 
8. Ensure the CONDITION combo box has 2 text values.   Select any 

value. 
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9. Now, click the Attributes tab and check the attributes populated into 
the database.  Ensure a numeric value appears in the CONDITION 
field and all other fields are populated (except ID).  

 

   
 

10. If necessary, go back into ArcPad Studio and edit the form. 
 

 
 
 
Challenge Topic 
 
Use ArcPad Studio and edit the structures.apl file. 
 
Make the following changes: 
 

1) Edit the layer definition file so the TECHNICIAN combo box 
automatically defaults to “your last name” and the combo box is 
disabled on the form. 

 
2) Edit the layer definition file so the CONDITION combo box 

automatically defaults to “Good”. 
 

3) Ensure that the user CANNOT enter a feature that is NOT in the 
current list of features. 

 
 
Test your new form in ArcPad to ensure these changes are in effect. 
 
  
 
 
 



 
 

Section 10 
 

 
 

Customizing the ArcPad Interface 
 

 
 
 
Section 10 Objectives:   
 

At the end of this section, you will be able to:  
 

 
o Setup an ArcPad skin file on your desktop PC 
 
o Create an ArcPad configuration file using ArcPad Studio 

 
o Create a custom toolbar 
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Customizing the ArcPad Interface 
 
 
In this section you will learn how to customize the ArcPad interface.   This can 
easily be done without any programming experience.   However, if you wish to 
develop your own customized tools, you need to be familiar with the VBscript 
programming language. 
 
First, you are going to learn how to configure an ArcPad skin file.  A skin file is 
essentially a bitmap with a window for the ArcPad application to run within.   By 
using a skin, you can demonstrate ArcPad on your PC while presenting to others 
an indication of what ArcPad actually looks like when running on an iPAQ or 
other handheld device.   
 
Secondly, you will use ArcPad Studio to create a default configuration file.  You 
will create a new tool bar that contains only necessary tools for your application.  
By minimizing the number of tools, you can streamline the process of collecting 
GPS data for users and minimize the amount of training required.     
 
Procedures to setup and run a skin from the ArcPad desktop icon  
 

1. Open Windows Explorer and navigate to the d:\tec7133\arcpad_skins 
folder.   

 
2. Copy the 2 files (3650.skn, 3650.bmp) that reside in this folder and put 

them in the same folder as your ArcPad program file (c:\Program 
Files\ArcPad\WinNT) folder.  Minimize or close Windows Explorer. 

 
NOTE:  The skin files were obtained from ESRI’s web and are included 
on your course CD. 
 

3. From the Windows desktop, right click on the ArcPad icon. 
 
4. Click Create Shorcut. 

 
5. Right click on the new shortcut icon just created on you desktop and 

select Properties.    
 

6. Click on the Shortcut tab. 
 

7. In the Target section, enter the following text (no spaces) after the 
path to the ArcPad executable: 

 
 /skin="c:\Program Files\ArcPad\WinNT\3650.skn"  
 

NOTE:  Ensure there is one space after the path to the executable and 
the line above.   
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8. Click OK when finished. 
 
9. Double click on the ArcPad icon to ensure your setup is complete.  

ArcPad should now run within the window of the iPAQ 3650 skin.    
 

10. Close ArcPad. 
 

11. Rename the short cut icon accordingly. 
 
 

Extra:  Setup another shortcut to ArcPad using a skin for the GeoXT.   Use 
the GeoXT.bmp and GeoXT.skn files. 

 
 
Creating a default configuration file 
 
It is very easy to customize the appearance of ArcPad.   In this exercise you will 
create a new toolbar.  Next, you will put some commonly used tools on the new 
toolbar.  Finally, you will set the visibility for all toolbars and the status bar.  
 

1. Open ArcPad Studio. 
 
2. From the File menu, click New and choose Configuration. 
 
3. From the File menu, click Save.  Navigate to the d:\tec7133\export 

folder.    
 
4. Name the file arcpad.apx and then click Save. 

 
5. Click on the Toolbars  icon. 

 
6. Click Add. 
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7. Type NCTC in the Name section.  

 

   
 
8. Now, from the Toolbar dialog, double click on the tools bel ow in the 

following order (you will have to scroll to locate them):  
 

Open ArcPad Map 
Layers 
GPS Position Window 
Zoom In 
Options 
Refresh the map 

 
9. Your screen should match the example below.    
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10. Now double click on the Open ArcPad Map tool you just added to your 

new toolbar.   A new Tool Properties dialog appears. 
   
11. You now will assign sub menus.  Double click on Save the current map 

to add this tool as a sub menu choice.      Next add the Exit tool.   Your 
dialog should match the example below.  Click OK when finished 
adding these 2 tools. 

 

      
 

12. Next, add the Add Layer and New Layer tools as sub menus for the 
Layers tool. 

 
13. Add the GPS Enable tool as a sub menu for the GPS Position tool. 

 
14. Add the Zoom To Previous, Zoom to Full Extent and Zoom to Layer 

tools as sub menus for the Zoom In tool 
 

15. After you finish, click OK and close the Toolbar dialog. 
 

16. In our custom configuration, we only want the Draw and NCTC toolbar 
to show.   Click on the Toolbars  icon. 

 
17. Uncheck the Main and Browse toolbars and ensure a check is placed 

next to the Draw and NCTC toolbar.   Click OK. 
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18. Double click on <Config>. 
 

 
 

 
19. In our custom configuration, we do not want the Status Bar to be 

displayed.  Uncheck “Initially Visible”.   Your screen should matc h the 
example below.  Click OK when finished. 

 

        
 

 
20. From the File menu, click Save. 

 
21. From the File menu, click Exit to close out of ArcPad Studio. 

 
22. To test on your PC.   Copy your new ArcPad configuration file to the 

c:\Program Files\ArcPad\System folder. 
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23. Open ArcPad using a skin and ensure you new toolbar is displayed.  
Also, check to ensure the Status Bar is NOT displayed. 

 
24. Connect your iPAQ to the cradle and setup as a Guest. 

 
25. Copy the file to the My Pocket PC\ArcPad\System folder. 

 
26. Test your new configuration on your handheld device.  

 
NOTE: If you want to restore the original default ArcPad configuration 
settings, simply delete the arpad.apx file from the System folder. 
 
 
CHALLENGE TOPIC:  Ensure that all other toolbars associated with any 
applets do not appear when you open ArcPad.   Also, move the Draw toolbar 
below the NCTC toolbar.   
 
EXTRA CREDIT:  Display a message box that displays “Welcome to 
Phoenix” when the ArcPad application is launched.    
 
Hint:  Associate the script below with the onstartup event for the Application 
object.   

 
      sample script 
 

msgbox “Welcome to Phoenix”  


